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Chapter 1: Overview

This user’s guide is designed to introduce you to the main Cedara I-Response for
NIH application functions. Each chapter provides easy, step-by-step instructions
to help you use the application. Wherever possible, the illustrations reflect the
application’s standard configurations.

About the Application

The Cedara I-Response for NIH application provides sophisticated image
manipulation and tumor tracking functionality as well standard image review tools.

Since measurements are acquired and tracked over multiple studies (i.e., pre and
post treatment), you can use this data to assist you when evaluating the results of
treatment therapy or disease progression. The application allows you to track and
record tumor response by measuring lesions according to Response Evaluation
Criteria in Solid Tumors Group (RECIST), World Health Organization (WHO)
response criteria, and total volume calculations.

Caution: The application presents patient studies on a monitor in various
ways. It does not interpret image data to generate a diagnosis.
Diagnostic interpretation is the user’s responsibility.

Note: The Cedara I-Response for NIH application is intended for research
purposes only.
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Safety Precautions

This section contains a list of safety precautions that you must be aware of when
using the Cedara I-Response for NIH application.

Repetitive Strain Injury

As with all computer systems, there is a risk of repetitive strain injury if the
workstation is used excessively. Repetitive strain injury can include symptoms
such as eyestrain, backache, and so on.

WARNING: Excessive use of the workstation may result in repetitive strain
injury.

Lossy Compressed Images

It is possible to misinterpret images that are lossy compressed due to the loss of
information from the image. To avoid misinterpretation, the application labels all
images that are lossy compressed.

Caution: Lossy compressed images are subject to misinterpretation due
to information loss. Lossy compressed images must not be
used for primary diagnostic interpretation unless approved for
use.
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Chapter 1: Overview

Date and Number Format

The application uses the date format and number format specified by your
workstation’s regional settings. You should check your regional settings to ensure
that your workstation uses the most common date and number format used in
your region to avoid confusion. We also recommend that you set the workstation
to recognize four-digit years.

> To check your workstation’s regional settings

1. Inthe Taskbar, click Start, Settings then select Control Panel.

2. Double-click Regional and Language Options or Regional Settings (as
appropriate).

3. Ensure that you have selected the most common language, humber, and date
settings used in your region. The date style should include a four-digit year.

4. If you have made any changes, restart your operating system.

Power and Hardware Failure

Due to uncontrollable events such as power and hardware failure, the workstation
must not be the only source of image data for diagnosis. Image data must be
available from other sources such as scanner consoles, archives, and/or films.

Caution: The workstation must not be the only source of diagnostic
image data.

Image data can be lost if the workstation is shut off abruptly while a study is being
transferred to the hard drive (e.g., there is a power failure or the workstation is
accidentally unplugged). The application may display the message “No Image -
check manual” when you load the study for review. In this case, you must delete
the study and transfer it again.

Caution: We recommend that you install an Uninterruptible Power Supply
(UPS) to support the workstation in the event of power failure.
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Magnetic Interference

The images displayed on the workstation’s monitor(s) can be distorted by strong
magnetic fields; therefore users should consult the OEM's recommendations
concerning placement of electronic equipment in proximity to the workstation.

Caution: Position the workstation according to the OEM’s
recommendations on placement of electronic equipment.

Studies with Contrast

There is a contrast field on many MR and CT scanners where the type and
amount of contrast can be entered. Due to the way in which DICOM (Digital
Imaging Communications in Medicine) fields are interpreted by the application,
this field must be complete for the application to recognize that the study was
acquired with contrast. If you want the application to recognize the study as one
that was acquired without contrast, leave the field blank.

Caution: On many MR and CT scanners, the type and amount of contrast
must be entered in the contrast field. If the field is left blank, the
application will indicate that the study was acquired without
contrast.

Computer Virus Protection

Computer viruses can prevent the application from working properly. We
recommend you protect the workstation with anti-virus software. Contact your
System Administrator for further details.

Caution: We recommend that you install anti-virus software on your
workstation.
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Chapter 1: Overview

Customer Support

For applications support, please contact National Cancer Imaging Archive (NCIA)
Customer Support:

* |In North America, call 301-451-4384 or toll-free 1-800-668-7990

e Email ncicbh@pop.nci.nih.gov

About this Guide

This user’s guide assumes that you are familiar with the basic operation of
personal computers, such as how to turn them on, how to use the mouse, and
how to work in the Microsoft Windows Operating System environment. If you are
not familiar with these operations, please refer to the documentation provided with
your workstation.

Visual Cues

» Words shown in large, boldface text, such as Done, indicate buttons and tools
that can be clicked with the mouse.

» Words shown in regular, boldface text, such as exit, indicate characters that
you must type into the keyboard exactly as they appear (i.e., if you are
instructed to type exit, you should type the characters exactly as they are
printed).

» Words shown in uppercase, such as ENTER, indicate keys on the keyboard
that should be pressed. If several keys appear together separated by hyphens
(e.g., CTRL+ALT+DEL), it means that you should press all three keys
simultaneously.

» Words shown in italics are used for emphasis.
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Notes, Cautions, and Warnings

Note: Notes are used to indicate information which may be helpful or of special
interest to the reader.

Caution: Caution messages indicate procedures which, if not observed,
could result in loss of data on the hard disk or damage to the
equipment. Do not proceed beyond a Caution message until the
indicated conditions are fully understood and met.

WARNING: Warning messages indicate procedures or practices which, if
not observed, could result in personal injury to the user or the
patient. Do not proceed beyond a WARNING message until all
of the indicated conditions are fully understood and met.
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Chapter 2: Installing the Cedara I-Response
for NIH Application

This chapter describes how to install the Cedara I-Response for National Institute
of Health (NIH) application.

It is intended to be used by service personnel who have a working knowledge of
the Microsoft® Windows® operating systems. Please consult the appropriate
Microsoft documentation before using this guide if you are not familiar with
Microsoft® Windows® operating systems.

Workstation Requirements

The application runs on a workstation that normally consists of a personal
computer, keyboard, mouse, and one monitor. You can use a two-button mouse, a
three-button mouse, or a wheel mouse. The middle button on the three-button
mouse and the wheel button on the wheel mouse have specific functions that are
described in the appropriate sections of this user’s guide.

A workstation that is intended to be used in a clinical environment should meet the
recommended requirements.

It is important to note that these requirements are only a guideline. Each
installation will have different requirements based on the types of images being
viewed, the number of images being viewed, as well as other considerations, such
as the operating system services which may be running in the background.

WARNING: Use only workstations that have the proper electrical
certification.
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To avoid system overload caused by resource contention, we recommend you do
not install any other graphic intensive applications on the workstation.

Table 2-1: Cedara I-Response for NIH Workstation Requirements

Component Recommended Requirement

Processor Intel® Xeon™ 3.2 GHz

Memory 2 GB RAM

Hard Drive 40 GB

Video Card Any modern video card

Monitor One 19" (or larger) CRT or flat panel color monitor.
Network Interface Card 10/100/1000 BaseT

(NIC)

WARNING: Use only workstations that have the proper electrical
certification.

When upgrading the system, the first item to upgrade is memory. Displaying and
manipulating highly detailed images is a memory intensive operation; therefore,

the system requires plenty of on-board system memory (i.e., RAM), as well as a
high quality video card which has sufficient VRAM (i.e., video RAM).

Supported Operating Systems

You can install the Cedara I-Response for NIH application on the Microsoft®
Windows® XP Professional operating system with Service Pack 2.

Installing the Application

The following section describes how to install the Cedara I-Response for NIH
application. This section also describes how to configure the application’s default
port.
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Chapter 2: Installing the Cedara I-Response for NIH Application

> To install the application

1. Shut down all other applications running on the workstation, including any
third-party antivirus or utility applications (e.g., Norton AntiVirus®, Microsoft
Windows AntiSpyware).

2. In Windows Explorer, navigate to the folder where you saved the Setup.exe
file. Double-click Setup.exe.

3. Click OK to confirm that you want to install the application.

I-Response Setup E
?2)

\{/ To start I-Response Setup, click QK. To quit without installing, click Cancel,

oK I Cancel |

4. At the Welcome dialog box, click Next.

iiél- Cedara I-Response NIH

Welcome to the Cedara I-Response NIH Setup
Wizard

The installer will quide you through the steps required ta install Cedara |-Responze MIH on your
computer,

Wi RMING: Thiz computer program is protected by copyright law and international reaties.
Unautharized duplication ar distibution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prozecuted to the marimum extent possible under the law.

Cancel < Back | Mext > I
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5. Inthe Customer Information dialog box, type the appropriate name and
organization in their respective fields, then click Next.

i‘.§ Cedara I-Response NIH

Customer Information

Enter your name and company or organization in the boxs below. The installen will uze thiz infarmation
for subsequent installations.

Mame:

Organization:

Cancel < Back | Mewut » I
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Chapter 2: Installing the Cedara I-Response for NIH Application

6. Inthe Select Installation Folder dialog box, do the following:

» Click Browse... to select the destination folder to install the application. The
system displays the default destination folder for the installation files.

» Select the “Everyone” radio button if you want every user that logs onto the
workstation to have access to the application. If you select the “Just me”
radio button, only the user currently logged on to the workstation can
access the application.

* Click Next.

{& Cedara I-Response NIH M= B3
=3

o

Select Installation Folder

The inztaller will inztall Cedara |-R ezponze MIH to the following folder.

Toinztall in thiz folder, click "Mext”. Taoinztall to 5 different folder, enter it belaw or click "Browse".

Faolder:

C:\Proaram Files\Cedarahl-Responze_NIHY Browse... |
Dizk Cost.. |

Install Cedara |-Response MIH for pourself, or for anyone who uses this computer:

' Everyone
 Just me

Cancel < Back | Mext > I
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7. Click Next to install the application.

jiit Cedara I-Response NIH

Confirm Installation

The ingtaller iz ready to inztall Cedara |-Rezponze HIH on your computer,

Click "Mext" to start the installation.

Cancel

< Back

| Mewut » I

8. The Setup Wizard begins to install files and displays a progress bar indicating
the progress of the installation.

jiit Cedara I-Response NIH

Installing Cedara I-Response NIH

=l 3

Cedara |-Responze MIH iz being installed.

Please wait...

Cancel I

< Back

fdewt >

12
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Chapter 2: Installing the Cedara I-Response for NIH Application

9. After the installation is complete, click Close.
i Cedara I-Response NIH

Installation Complete

Cedara |-Responze MIH haz been successfully inztallad,

Click "Close" to exit,

Fleaze uze Windows Update ta check for arw critical updates to the MET Framewark.

[Eatice] < Back | Cloze I

10. At the Setup succeeded dialog box, click OK.

I-Response NIH Setup

Setup succeeded,

Configuring the Application Port

By default, the application uses port 8889 to communicate with the Web server. If
you need to change the application’s port number, use the following procedure.

> To configure the port number

1. On the Desktop, right-click the I1-Response shortcut and select Properties.

2. Inthe Target field, replace the default port number (8889) with the desired port

LR
Bapanse number.

MNIH

3. Click Apply then OK.

13
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Uninstalling the Application

This section describes how to remove the Cedara I-Response for NIH application
files from your computer.

Caution: When you uninstall the application, all of the application files are
removed, including the configuration files, registry settings and
license files.

> To remove the application files
1. Open the Control Panel.
2. Double-click Add or Remove Programs.
3. Inthe list of currently installed programs, click Cedara I-Response NIH.

4. Click Remove.

Add or Remove Programs B

\:;:)‘ Are wou sure you wank to remove Cedara I-Response MIH from your computer?

Yes Mo |

5. Click Yes to remove the application.

6. The system displays a progress bar while it uninstalls the application.

Cedara I-Response NIH

EENENEENERNERNENNENEENEEN
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Chapter 2: Installing the Cedara I-Response for NIH Application

Upgrading the Application

This chapter describes how to upgrade the application from your current version
to Cedara I-Response for NIH 1.1.

> To upgrade the application

1. Ifthe Cedara I-Response for NIH application is running, close it.

2. Uninstall your existing Cedara I-Response for NIH application (see
“Uninstalling the Application” on page 14).

3. In Windows Explorer, navigate to the folder where you saved the Cedara I-
Response for NIH 1.1 Setup.exe file. Double-click Setup.exe.

4. Follow the on-screen instructions as described in “Installing the
Application” on page 8.

15
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Chapter 3:

Getting Started

This chapter briefly describes how to start the application. It also describes how to
use the help system and how to exit the application.

Starting the Application

Use the following procedure to start the application.

> To start the application

1.
2.

3.

|-Response
MIH

Start the workstation.
When you are prompted to log on, press CTRL-ALT-DEL.

In the Enter Network Password dialog box, type your user name and
password.

Click OK.

To open the application, do one of the following:

 Inthe Taskbar, click Start, Programs, Cedara Software, I-Response.
» On the Desktop, double-click the I-Response NIH icon.

The Cedara I-Response for NIH application Main Review window opens.

Note: For details on using the sample online Study List, see “Selecting and

Loading Patient Studies” on page 17.

15
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Using the Help System

The online help system provides quick access to user instructions.

> To use the online help
1. From the Help menu, select Contents.
2. The application displays the online help in a separate window.

3. Use the following features to navigate the help system and find the required
topics:

» Click Contents to display a list of topics available, then double-click the
topic you want to view.

e Click Index to display a list of keywords from which you can select a topic.
Type in the first few letters of the keyword you are looking for, then double-
click the keyword. This is often the easiest way to find a topic.

» Click Search to find all topics that contain a keyword. Type the keyword
you want to find, click List Topics, then click the desired topic in the list
displayed.

» Click Back to return to the last topic viewed.

Exiting the Application

This section describes how to exit the Cedara I-Response for NIH application.

> To exit the application
1. From the File menu, select Exit.
2. When the application asks if you really want to quit, click Yes.

3. The application closes and returns you to the desktop.

16
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Chapter 4. Selecting and Loading Patient

Studies

This chapter discusses selecting and loading patient studies for review.

The application uses an online Study List to display patient studies. The online
Study List resides independently from the local application in a web-based
environment. User authentication is required to access patient studies.

Note: For the purposes of this User’s Guide, a sample online Study List is
depicted. It is not intended to replicate the online Study List environment
used by NIH.

Accessing the Online Study List

Accessing the online Study List requires a username and password, and
determines what application tools are available for use. The availability of some of
the application’s tools is driven by user permissions in order to prevent their use
by unauthorized persons. The appearance, or non-appearance of certain menu
items depend on what type of permissions you have. For more information on the
application’s user permissions features, see “Understanding Markup
Management” on page 39.

Use the Log on feature provided to log on to the Online Study List to view patient
studies and use the application’s available tools.

Sample Log On Feature

Log in to view patient studies
Username: | JDoe and use the application’s tools

Password: | sssese
Login |

17
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After successfully logging on, the online Study List displays as represented by the
sample below.

Sample Online Study List

A Study List - Microsoft Internet Explorer

File Edit ‘“iew Favorites Tools  Help :,l'-
e Back ~ ‘J \ﬂ @ \7h /'T' Search * Favatites a‘ Media 6‘,} D?.z - :", Lj J ﬂ
Address |@ http:/] vebServerlameiStucyList V| Go Links

—

e

Advancing Healthcare Through C'
oo Innovative Software Solutions

CEDARA"
SOFTWARE

(Ve

Column Headings = Patient Name Stady Date Series Number Series Description #Instance Modality X
— CompressedSamples™CT1 20040119 1 1 CT Ld]
CompressedSamples™CT2 20040118 1 1 CT [ ]
CompressedSamples™R1 2004011% 1 1 ME ]
CompressedSamples MR 2 20040119 1 1 ME [ ]
CompressedSamples WE3 20040119 1 1 ME L]
Study List — CompressedSamples"IMR4 2004011% 1 1 ME. O
DEMOPD_00001 20020503 1 SAGTI 17 ME. O
DEMOPD_00001 20020503 2 ANTAT T2(F) 20 ptinzy O
DEMOPD_00001 20020503 3 Axial. FLATR. 20 ME. ]
DEMOPD_00001 20020503 4 ATTAT T1 20 ME. O
L— | DEMCPD 00001 20020503 5 PERF DRYRUN 14 ME O
s
é Done ﬂ Local intraner‘ -

I
<«4— Load Button

Sample Study List Columns

The columns in the sample online Study List above provide patient study and
series information described in Table 4-1.

Table 4-1: Sample Study List Columns

Patient Name The patient’'s name
Study Date The date the study was created
Series Number The total number of series (i.e., acquisitions) in the study

18

=
e —
[—
T

——

CEDARA"®
SOFTWARE



Chapter 4: Selecting and Loading Patient Studies

Table 4-1: Sample Study List Columns (Continued)

Column Description

Series Description The image views

Instance The instance number

Modality The source modality of the study
X The study selection column

Selecting and Loading Studies for Review

You can select, load and depending on the type of permissions you have, use the
following tools to analyze and review patient studies in the application’s Main
Review window (see “ Using the Main Review Window” on page 21):

» Lesion Analysis Tools — Measure lesions and define regions of interest (ROI)
using the Contours, RECIST, Crosshair and Non-target tools to compare
lesions over time. For more information on using the Lesion Analysis tools, see
“Using the Lesion Analysis Tools” on page 35.

» Review Tools — Perform standard image review tasks (i.e., zoom and pan
images). For more information on using the Review tools, see “Using the
Review Tools” on page 53.

WARNING: To ensure optimal clarity, the application loads low fidelity
images progressively and displays the label “Downloading in
progress” until the image has finished loading. Diagnhosis
should not be performed while the download is in progress. If
the image is compressed, the Lossy Compressed label and
compression ratio displays throughout the download.

Note: You cannot load studies from more than one patient. If you load multiple
studies, ensure they belong to the same patient. Otherwise, the
application displays an error message and prevents you from loading the
studies.

19
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Chapter 5: Using the Main Review Window

Loaded images are displayed in the Main Review window. This chapter describes
the features of the Main Review window which consists of the Review Toolbar,
and popup menu.

The Main Review window also includes:
* the Lesion Group Box (see “Using the Lesion Analysis Tools” on page 35);

» the Graphics Layers Group Box (see “Working with Graphic Layers” on
page 35);

» the MPR Properties Group Box (see “Changing the MPR Properties” on
page 54); and

e The Synchronized Scroll Bar (see “Synchronized Scrolling in 2D Lesion
Viewing Protocol” on page 32).

Note: For information on viewing modes, see “Using the Viewing Protocols”
on page 27.

21
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The example below displays the Main Review window.

Active Viewport Review Toolbar

[-ToT=]

- Lesions

I Group

| — | Box
Graphics
Layers
Group
Box

—_ MPR

Mot Properties

. | Group

— Box

e || —

eady NERRNNNRNNNRNNNRNNENNNRNNNENRNRNRNERRY

Status Bar

Caution: The Main Review window displays two types of error messages;
rendering server errors display in the Status Bar and application
errors display as popup dialogs.

22
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Chapter 5: Using the Main Review Window

Using the Review Toolbar

The Review Toolbar provides the main access to the application’s review tools. As
with all Windows applications, you can access some of the functions from the
main menus in the menu bar. Some of the more frequently used tools are also
available from the popup menu (see “Using the Popup Menu to Access Lesion
Analysis and Review Tools” on page 23)

Note: You can expand the Review Toolbar to access hidden review tools. To
expand the Review Toolbar, click the Toolbar Options button.

Toolbar Options Button

Using the Popup Menu to Access Lesion
Analysis and Review Tools

As with most Windows applications, you can right-click a window (i.e., image
within a viewport) to access a popup menu. Depending on your user permissions,
the popup menu provides access to the application’s Lesion Analysis tools and
common review tools. For information on user permissions, see “Understanding
Markup Management” on page 39.

> To use the popup menu

1. Right-click any viewport and select the appropriate option from the popup
menu.
-

WidthjfLewel
Pixel Walue
Magnify Glass

Correlate

RECIST

Crosshair

Mon karget

Disp. Area 3
Conkours 3
Delete all

Auto WidthiLevel
Width/Level Presets
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2. The application dismisses the menu and performs the operation. If you select

one of the review tools (e.g., Window/level Presets), the application changes
‘%{} the function of the left mouse button to the selected tool and remains set to

that function until you select a different tool. The function of the left mouse
button is indicated by the pointer. For example, if the left mouse button is set
to Window level, the mouse pointer appears as shown here. For information
on using all of the applications review tools, see “ Using the Review Tools”
on page 53.
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Chapter 5: Using the Main Review Window

Selecting Other Studies from the Sample
Online Study List

When you finish reviewing the current study, you can return to the sample online
Study List to access additional studies for review.

Note: To access the sample online Study List, see “Accessing the Online
Study List” on page 17.

Viewing Patient Information

You can access in-depth patient study information while in the Main Review
window.

> To view the patient’s information
1. Inthe Review Toolbar, click Patient Information.

2. The application displays the Patient Information dialog box.

k|
Filter Group Attributes | Save To File
Mame | Tag | Value =
blueprint:irmageType 6509,11e8 3D
dicom:accessionhumber 000,000 00002
dicorn: acquisitionDate 0002,0022 20020502
dicorn :acquisitionhatr i 0018,1310 04256419240
dicorn:acquisitionMurmber 0020,0012 0
dicorn:acquisitionTime 0o02,0032 113228
dicorn :additionalPatisntHistory 0010,21k0
dicorn:angioFlag 0018,0025 M
dicom:bitssllocated 0028,0100 16
dicorn:bitsStored 00ze,0101 16
dicom :bodyPartExamined 0018,0015  BRAIN
dicom :cardiachumberOfimages 0018,1090 0
dicorn:calurmns 0028,0011 255
dicom :compressionCodeRetired 0028,0060  NOME
dicom :dataSetSubtypeRetired 0008,0041 | IMA NONE
dicom:dataSetTypeRetired 0008,0040 0
dirorn:deviceSerialMumber 0018,1000  000000013936mr 1
dicornechoMNumbers 0018,0086 1
dicom:echaTime 0018,0021  105.0
dicom:echaTrainLength 0018,0091 8
dicom:flipangle 0018,1314 90.0
dicom:frameCfReferencelid 0020,0052 | 1.2.840.113619,2,5,1762534192,
dicom:heartRate 0018,1088 0
dicorm :highBit 0028,0102 15
dicam:imageComments 0020,4000  BRAIN
dicam:imageDate 0005,0023 20020503
dicom:imageDimensionsRetired 0028,0005 2
dicom:imageFor matRetired 0028,0040 RECT -
1| | oz

3. Use the scroll bars to view all of the available information.
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4. Using the Patent Information dialog box, you can:
« click the Group Attributes button to sort by group,
« click the Save to File button to save patient information;
« click the column headers to sort on Name, Tag or Value; and
» enter text in the Filter field to filter on Name, Tag or Value.

5. When you are finished, click Close.

Using the Three-Button Mouse or Mouse
Wheel

If you have a three-button mouse or a mouse-wheel, you can use the mouse to
perform specific review tool functions. The three-button mouse and mouse-wheel
actions are described in various procedures in “Using the Review Tools” on
page 53.
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Chapter 6: Using the Viewing Protocols

The application’s supports two viewing protocols which are invoked when you
load two or more lesion series into the Main Review window for comparison. Each
viewing protocol is optimized for the type of image being loaded and the real
estate comprising your monitor.

This chapter describes the following two viewing protocols:
» 2D Lesion (see “2D Lesion Viewing Protocol” on page 29)

» 2D & MPR Lesion (see “2D & MPR Lesion Viewing Protocol” on page 34)

Note: The application does not support multi-phase or multi-frame data.
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Understanding the Viewing Protocols

This section describes the 2D Lesion and 2D & MPR Lesion viewing protocols
supported by the application.

Table 6-1: Understanding the Viewing Protocols

Views

Views available when you

load Viewports
2D View 2D MPR Lesion View

one 2D image series loads in one viewport

loads in two viewports

‘/ loads in one viewport

two 2D image series

one 3D image series

two 3D image series loads in two viewports

loads in two viewports

ANIANANANAN

two series (one is not a 3D
image series)

Note: The criteria that determines if a series is 3D renderable includes any
modality except CR and DR with more than four slices, and has the
correct DICOM acquisition properties based on the OpenEyes Toolkit
rules.

Selecting the Viewing Protocol

Use the following procedure to select the required viewing protocol.

> To select a viewing protocol

1. From the View menu, select the required viewing protocol from the dropdown
menu.

Yiew Help

20 Lesion
20 & MPR. Lesion

2. The application switches the viewing protocol and displays the images.
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Chapter 6: Using the Viewing Protocols

2D Lesion Viewing Protocol

The 2D Lesion viewing protocol provides a conventional approach to viewing
images. In this view, the images are displayed in their original acquisition plane.

When you load other modalities (e.g., MR) in to the 2D Lesion viewing protocol,
the application displays the images in the 1x1 layout (i.e., one viewport) by
default; however, you can manually change the layout (see “Changing the
Layout in 2D Lesion Viewing Protocol” on page 29). The example below the
illustrates 2D Lesion viewing protocol in 2x2 layout when you load an MR study.

Changing the Layout in 2D Lesion Viewing Protocol

The image layout specifies the number of rows and columns in which the images
are displayed on a monitor. Each image area is referred to as a viewport. For
example, if you select a 2x2 layout, there are four viewports.

29
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> To change the image layout

1. Inthe Review Toolbar, click the Layout button and select one of the
predefined image layouts (e.g., 2x2).

Apply ko all

2. The application displays the 2D images in the selected layout.
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Chapter 6: Using the Viewing Protocols

Scrolling through Images in 2D Lesion Viewing Protocol

The application provides several standard methods of scrolling through images in
2D Lesion viewing protocol. You can:

 scroll using a three-button mouse;
 scroll using the vertical scroll bar; and

 scroll using the keyboard.

Note: For information on synchronized scrolling in the 2D Lesion Viewing
Protocol, see “Synchronized Scrolling in 2D Lesion Viewing
Protocol” on page 32.

Note: For information on melting through images using the mouse-wheel, see
“To melt through the images using the mouse-wheel” on page 57.

> To scroll using a three-button mouse

1. Load and display the required 2D Lesion series (see “ Selecting and
Loading Studies for Review” on page 19.

Fh 2. Middle-click any viewport and with the mouse button pressed:
= « drag the mouse pointer up to scroll backward through the images; or

» drag the mouse pointer down to scroll forward through the images.

> To scroll using the vertical scroll bar
« scroll up to scroll backward through the images; or

¢ scroll down to scroll forward through the images.

> To scroll using the keyboard
e press the UP-ARROW key to scroll backward through the images; or

« press the DOWN-ARROW key to scroll forward through the images.
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Synchronized Scrolling in 2D Lesion Viewing Protocol

Synchronized scrolling allows you to scroll images in two viewports at the same
time. When one viewport is scrolled, the second viewport scrolls in equal
increments, i.e., by the same number of images. You can anchor synchronization
by locking an arbitrary image in each viewport.

> To synchronize scrolling

1. Load and display two 2D Lesion series (see “Selecting and Loading
Studies for Review” on page 19.

ﬁ:’ 2. In the review Toolbar, click Link Viewers.
3. Using the vertical scroll bar in either viewport:
« scroll up to scroll backward through the images; or

 scroll down to scroll forward through the images.
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Chapter 6: Using the Viewing Protocols

4. The application scrolls images in both viewports simultaneously.

Synchronized scrolling in
inactive viewport

Manual scrolling in
active viewport

Synchronized
scrolling in inactive
viewport

Manual scrolling in
active viewport

Note: You can anchor synchronized scrolling by locking an arbitrary image in
each viewport.

Note: If an image in one viewport cannot be aligned with an image in another
viewport, the latter viewport will not advance; rather, a message displays
stating “Not Linked".
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2D & MPR Lesion Viewing Protocol

2D & MPR Lesion viewing protocol allows you to display multi-planar reformat
(MPR) views of images. This allows you to view a patient’s series in multiple
orthogonal planes. For example, if the original acquisition plane was axial, MPR
allows you to view the images in the coronal and sagittal planes. This is useful
since planes orthogonal to the acquisition plane can be more appropriate for
evaluating structures of interest.

The following are prerequisites for viewing images in this view:
» The series must contain at least four images.

* The images in the series must have been acquired in the same orientation, at
the same angle and at the same table height.

Note: For information on adjusting the MPR properties see “Changing the
MPR Properties” on page 54.

The example below depicts 2D & MPR Lesion viewing protocol displaying Axial,
Saggital and Coronal orthongonal planes.
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Chapter 7. Using the Lesion Analysis Tools

The application’s Lesion Analysis tools help you track, compare and record tumor
development by:

 creating graphic layers to save, edit and delete graphic elements (e.g., lesion
measurements and labels); and

» measuring lesions and defining regions of interest using the Contours, RECIST,
Crosshair and non-target and tools.

Note: To change the image display parameters (e.g., window settings, zoom,
pan), see “Using the Review Tools” on page 53.

Note: We recommend that you use MR and/or CT data to perform Lesion
Analysis.

Working with Graphic Layers

The application allows you to create and save graphic elements (e.g., lesion
measurements and labels) in separate graphic layers. You can create graphic
elements in up to seven predefined graphic layers. Each layer can contain
multiple graphic elements.

The application displays all graphic layers at the same time; however, you can
show or hide graphic elements within each layer. When working with graphic
layers, you can edit the graphic elements on one layer without affecting any of the
other layers. Graphic elements on the active layer are displayed in orange.
Graphic elements on the inactive layer are displayed in blue.

You can also view graphic elements created by other users.

Note: For details on using the NT (non-target) layer, see “Using the Non-target
Tool” on page 54.
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The following example displays contours and crosshair measurements drawn on
two series using two Graphic Layers.

Graphic Layers Group Box —

Inactive Layer

Active Layer

Selecting Layers

To create graphic elements on different layers, you must first select the active
layer. Use the following procedure to select the active layer.

Note: If you are loading a series for the first time, application selects the Tumor
layer by default. If you are loading a series with previously saved graphic
elements, the application selects the last saved layer.

Note: Make sure you save your changes for the current active layer before
selecting a new active layer.
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Chapter 7: Using the Lesion Analysis Tools

> To select an active layer

1. Inthe Graphic Layers group box, select the appropriate layer from the Layer
dropdown list.

r—Graphic Lavers

Active Layer | Yizibility |

Layer: ITumnr vI
User: I a vl

Save |
Clear |

2. Create or edit graphic elements as required.

3. Inthe Graphic Layers group box, click Save.

Deleting Graphic Elements in Layers

Use the following procedure to delete all graphic elements in a layer.

Note: You cannot edit or delete graphic elements created by other users, see
“Understanding Markup Management” on page 39.

> To delete all graphic elements in a layer

1. Inthe Graphic Layers group box, select the appropriate layer from the Layer
dropdown list.

2. Click Clear.

3. When the application asks if you want to delete the graphics in the selected
layer, click OK.

Cedara I-Response E

\:;:/ Are wou sure you wank to delete all active graphics and kext?

oK I Cancel |
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4. In the Graphic Layers group box, click Save.

Showing or Hiding Graphic Elements

You can show or hide the graphic elements created by any user within each
graphic layer.

Note: You cannot hide the graphic elements in the active layer.

> To show or hide a graphic element
1. Inthe Graphic Layers group box, select the Visibility tab.
2. From the Layer dropdown list, select the appropriate layer.
3. Do one of the following:

* To hide graphic elements, clear the checkbox beside the corresponding
user name.

» To show graphic elements, select the checkbox beside the corresponding
user name.

—Graphic Layers

Bitive Laysr  Visibility |

Layer: ITumDr vI

User: [/ tempuser

[wl] JDoe
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Chapter 7: Using the Lesion Analysis Tools

Note: When you show or hide graphic elements, those created in the NT layer
along with the corresponding user name (under the Visibility tab), always
remain visible. For example, if you select the Tumor layer, the user name
which corresponds to graphic elements created in the Tumor layer is also
visible. In addition, the user name which corresponds to graphic elements
created in the NT layer also remains visible. If you clear the user name
which corresponds to the Tumor layer, the graphic elements are no longer
visible. If you clear the user name which corresponds to the NT layer, the
graphic elements become inactive (blue), but remain visible. For
information on graphic elements created in the NT layer, see “Using the
Non-target Tool” on page 54. For information on the application’s user
roles, see “Understanding Markup Management” on page 39.

Understanding Markup Management

The application’s Markup Management feature provides user account control in
order to manage the information (i.e., graphic elements) other users can view.
Authentication is based on the user name and password you use to log on to the
online Study List, and determines which applications tools are available for use.
User accounts can be assigned the following permissions:

» Read-write — You can create, edit, delete and save your own markups (i.e.,
graphic elements). You can view, but cannot edit markups created by other
read-write users.

» Read-only — You cannot create, edit or save markups (i.e., graphic elements).
You can view, but cannot edit markups created by other read-write users.
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The table below displays which application tools are available to read-write users
and which application tools are available to read-only users.

Table 7-1: Understanding Markup Management

Tools

Tools available if you are a...

Details
Lesion Analysis  Review

Read-write user ‘/ ‘/ All tools in the Review toolbar and
popup menu are enabled.

Read-only user ‘/ Contours, RECIST, Crosshair and

Non-target tools are disabled in the
Review Toolbar and in the popup
menu.

Note: For information on using the Lesion Analysis tools, see “Measuring

Lesions” on page 43. For information on using the Review tools, see
“Using the Review Tools” on page 53.
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Chapter 7: Using the Lesion Analysis Tools

Using Markup Management as a Read-write User

The following procedure describes how to use the Markup Management feature
as a read-write user.
> To use Markup Management as a read-write user

1. Log on to the online Study List using your user name and password
(“Accessing the Online Study List” on page 17).

2. Load and display the patient series (see “ Selecting and Loading Studies
for Review” on page 19).

3. The application displays your user name in the Graphic Layers group box
User field.

—Graphic Layers

Active Layer | Wisihility |

Layer: ITumor vl

User: |Readuitel): Current read-write user

Save |
[lear |

4. From the Layer dropdown list, select the required layer (see “ Selecting
Layers” on page 36).

5. Create markups as required (see “Measuring Lesions” on page 43).
6. Click Save.
7. The application prompts you to save your markups.

Cedara I-Response

\‘.\.’/‘ would vou like to save current modified markups GF any)?

oK I Cancel |

8. Click OK.

9. To show/hide markups from other users, select the Visibility tab from the
Graphic Layers group box and select/clear the appropriate user checkbox
(see “Showing or Hiding Graphic Elements” on page 38).

10. The applications displays markups created by the selected user.
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Using Markup Management as a Read-only User

The following procedure describes how to use the Markup Management feature
as a read-only user.

> To use Markup Management as a read-only user

1. Log on to the online Study List using your username and password
(“Accessing the Online Study List” on page 17).

2. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

3. The application displays your user name in the Graphic Layers group box
User field, and disables Contours, RECIST, Crosshair and Non-target tools
from the Review toolbar and the popup menu.

—Graphic Layers widthfLewvel
Active Layer | Yisibility | Pixel '.u'alue
Magnify Glass
Layer: ITumnl vl HECI=T
— ® Crosshair
Current read-only user pUser: |Headun|},|_|s vl P —
Lesion Analysis Disp. Area *|  Contours
tools disabled Conbalirs submenu disabled
Delete all
Save | Auka WwidthfLevel
widthiLewvel Presets
[lear, |

4. From the Layer dropdown list, select the required layer (see “Selecting
Layers” on page 36).

5. To show/hide markups from other users, select the Visibility tab from the
Graphic Layers group box and select/clear the appropriate user checkbox
(see “Showing or Hiding Graphic Elements” on page 38).

6. The applications displays markups created by the selected user.
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Chapter 7: Using the Lesion Analysis Tools

Measuring Lesions

Lesions are categorized as target (i.e., measurable) or non-target (i.e., non-
measurable). The application’s Lesion tools calculate measurements taken on
multiple images in multiple series, then displays them in the Measurements
Results Table for comparison. When you use the Lesion tools, you are calculating
the development of tumors using the following target and non-target response
criteria:

» Volume (see “Using the Contours Tool” on page 43)
» RECIST (see “Using the RECIST Tool” on page 50)
* WHO (see “Using the Crosshair Tool” on page 52)

» Non-target (see “Using the Non-target Tool” on page 54)

WARNING: After you create a measurement, itis possible to move it. When
reading measurements, always ensure the measurement is
associated with the correct geometry.

WARNING: The label “Uncalibrated” displays on all CR and DR modality
images that are uncalibrated. If images are uncalibrated, the
unit of measurement is in pixels. If images are calibrated, the
unit of measurement is in millimeters. If images are a
combination of calibrated an uncalibrated images, the unit of
measurement is undefined.

Note: In order to save your measurements, you must create and save them in a
graphic layer, see “Working with Graphic Layers” on page 35.

Note: To edit measurements, see “Editing Measurements” on page 64. To
export measurements, see “Exporting Measurements” on page 57.

Using the Contours Tool

This section describes how to use the Contours tool. When you use the Contours
tool, you are measuring the tumor’s total volume. The Contours tool calculates
volumetric measurements taken on multiple images in multiple series then
displays them in the Measurements Results Table for comparison. You can also
export volume measurements to a local data source (see “Exporting
Measurements” on page 57).
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The application provides three methods for creating contours around a region of
interest (ROI). You can:

* manually create contours;
» automatically create contours; and

» propagate contours from one image to another in the same series.

Note: To edit contours, i.e., delete, show/hide contour measurements or edit the
contour number, see “Editing Contour Measurements” on page 66.

Note: If your permissions to use the Cedara I-Response for NIH application are
“read only”, you will not be able to create, edit or save contours, see
“Understanding Markup Management” on page 39.

Manually Creating Contours

Use the following procedure to draw a freehand contour.

Caution: To copy contours, you must use images with the same matrix
size. For information on copying contours, see “Propagating
Contours” on page 49.
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Chapter 7: Using the Lesion Analysis Tools

> To manually create a contour

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:

* In the Review toolbar, click the Contours button and select Draw from the
' dropdown list.
EE. » Right-click the active viewport and select Contours, Draw from the popup
menu.
\_h_f_,f
widthLewvel
Pixel Walue

Magnify Glass
Correlate

RECIST

Craosshair

Mon kargek

Disp. Area »

Contours 3

Delete Al Segment;
Auko WidthLewel
Wwidth/Level Presets

3. Inthe first series, click and drag the mouse to draw a contour around the ROI.

4. Repeat Step 3 to draw additional contours on the second series.

Compars 5. From the Lesions group box, click the Compare button.
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6. The measurements display in the Measurements Results Table where the
third SeriesID column header represents the volume measurements taken in
the first series, and the fourth SeriesID column header represents volume
measurements taken in the second series.

7. |If desired, use the Active Layers dropdown list to draw contours on a different
layer, then repeat Steps 1 through 6 to display measurements in the
Measurements Results Table. The example below displays volume
measurements created using freehand contours in two series, in 1x2 view, in
two graphic layers.

Inactive
Layer

Measurements Results Table Active Layer

8. Click Save.
9. The application prompts you to save your markups.
Cedara I-Response

\‘_?/ wrould vou like to save current modified markups GF any)?

o4 I Zancel |

10. Click OK.
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Automatically Creating Contours

Use the following procedure to create a contour automatically using the Segment
tool.
> To automatically create a contour

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:

» In the Review toolbar, click the Contours button and select Segment from
' the dropdown list.
» Right-click the active viewport and select Contours, Segment from the
] popup menu.
‘Width/Lewvel
Pixel Walue

Magnify Glass
RECIST
Crosshair
Mon Earget

Disp. Area 3

Conkours
Delete Al ®» Segment
Auto Width/Lewel

‘Width/Level Presets

3. In the first series, click and drag the mouse to segment the ROI.

4. The application automatically creates the contour which defines the tumor.

Segmentation Automatic Contour
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Compare

Inactive
Layer

Repeat Step 3 to segment additional ROIs on the second series.
From the Lesions group box, click the Compare button.

The measurements display in the Measurements Results Table where the
third SeriesID column header represents the volume measurements taken in
the first series, and the fourth SeriesID column header represents volume
measurements taken in the second series.

If desired, use the Active Layers dropdown list to draw contours on a different
layer, then repeat Steps 1 through 6 to display measurements in the
Measurements Results Table. The example below displays volume
measurements created using segment contours in two series, in 1x1 view, in
two graphic layers.

Measurements Results Table Active Layer
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9. Click Save.

10. The application prompts you to save your markups.

Cedara I-Response

\‘_?/ wrould vou like to save current modified markups GF any)?

oK I Cancel |
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Chapter 7: Using the Lesion Analysis Tools

11. Click OK.

Note: If you draw a particularly long line, segmentation may not be successful
and the contour will not display.

Note: For optimal results, adjust the Window/Level Settings accordingly then
draw a line over the longest portion of the ROI, see “Defining Window
Presets” on page 59.

Propagating Contours

Use the following procedure to automatically copy a contour to subsequent
images within the series.
> To propagate a contour

1. Load and display the patient series (see “ Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:

» In the Review toolbar, click the Contours button and select the appropriate
' Contours tool (e.g., Segment) from the dropdown list.

» Right-click the active viewport and select the appropriate Contours tool
(e.g., Segment) from the popup menu.

3. Click and drag the mouse to draw or segment the ROI.

4. In the Propagate Contours group box, click the right (->) or left (<-) Image
buttons to display the next image.

Fropagate contours
’7 <-Image| Image-» |

5. The application automatically propagates the contour on to the next image in
the series.

6. Repeat Step 4 to continue propagating the contour as required.

7. Click Save.
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8. The application prompts you to save your markups.

Cedara I-Response E3

\?/-‘ Would yvou like to save current modified markups (iF any)?

oK I Cancel |

9. Click OK.

Note: If you are using the 2D & MPR view, you must draw contours on each
orthogonal plane to propagate them accordingly. You cannot propagate
contours from the original orthogonal plane to the middle and left
orthogonal planes.

Using the RECIST Tool

This section describes how to use the RECIST tool. When you use the RECIST
tool, you are measuring tumors using the target RECIST response criteria. The
RECIST response criteria estimates the development of a tumor using the longest
diameter (i.e., unidimensional). You can draw a maximum of ten RECIST lines.
The RECIST tool calculates RECIST measurements taken on multiple images in
multiple series, then displays them in the Measurements Results Table for
comparison.

> To measure a lesion using the RECIST tool

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:

* In the Review toolbar, click the RECIST button.

Right-click the viewport and select RECIST from the popup menu.

width Lenel
Pizel Yalue
MMagnify Glass

Crosshair

Mon target

Disp. Area »
Conkours 3
Delete all

Auko widthLewvel
widthfLewvel Presets
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Chapter 7: Using the Lesion Analysis Tools

3. Inthe first series, click and drag the mouse over the lesion to mark the longest
diameter. When you release the mouse button, the application displays the
name of the layer (e.g., Tumor x, where x is the layer number).

TFE TRA  TITFE17 ViR

4. You may, for instance, want to delete and re-draw the Tumor 3 RECIST
Add lesion: measurement. By default, the application increments the layer number of the
m next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the
“Tumor 3" label, click Add Lesion in the Lesion group box and select the
appropriate number from the dropdown list.

5. Repeat Step 3 to draw additional RECIST measurements on the second
series.

Compare 6. From the Lesions group box, click the Compare button.

7. The measurements display in the Measurements Results Table where the
third SeriesID column header represents the RECIST measurements taken in
the first series, and the fourth SeriesID column header represents RECIST
measurements taken in the second series.

8. If desired, use the Active Layers dropdown list to draw RECIST
measurements on a different layer, then repeat Steps 1 through 7 to display
measurements in the Measurements Results Table.

9. Click Save.
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10. The application prompts you to save your markups.

Cedara I-Response E3

\:{) Would yvou like to save current modified markups (iF any)?

oK I Cancel |

11. Click OK.

Using the Crosshair Tool

This section describes how to use the Crosshair tool. When you use the Crosshair
tool, you are measuring the tumor using the target WHO response criteria. The
WHO response criteria uses two measurements to estimate the development of a
tumor (i.e., bidimensional):

* the diameter of the tumor; and
 the perpendicular diameter of the tumor.

When you mark the longest diameter of the tumor using the Crosshair tool, the
application automatically marks the perpendicular diameter of the tumor. You can
draw a maximum of ten Crosshair lines. The Crosshair tool calculates WHO
measurements taken on multiple images in multiple series, then displays them in
the Measurements Results Table for analysis.

> To measure alesion using the Crosshair tool

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:
dulﬁh * In the Review toolbar, click the Crosshair button.
» Right-click the viewport and select Crosshair from the popup menu.

‘Width/Lewvel
— - Pixel Walue

Magnify Glass
RECIST

Crosshair

Mon Earget

Disp. Area 3
Conkours 4
Delete Al

Auto Width/Lewel
‘Width/Level Presets
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3. Inthe first series, click and drag the mouse over the lesion to mark the longest
diameter. When you release the mouse button, the application automatically
displays the perpendicular diameter of the lesion and the name of the layer
(e.g., Tumor x, where x is the layer number).

4. You may, for instance, want to delete and re-draw the Tumor 3 Crosshair
Add lesion: measurement. By default, the application increments the layer number of the
m next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the
“Tumor 3" label, click Add Lesion in the Lesion group box and select the
appropriate number from the dropdown list.

5. Repeat Step 3 to draw additional Crosshair measurements on the second
series.

Compare 6. From the Lesions group box, click the Compare button.

7. The measurements display in the Measurements Results Table where the
third SeriesID column header represents the volume measurements taken in
the first series, and the fourth SeriesID column header represents volume
measurements taken in the second series.

8. If desired, use the Active Layers dropdown list to draw Crosshair
measurements on different layers, then repeat Steps 1 through 7 to display
measurements in the Measurements Results Table.

9. Click Save.
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10. The application prompts you to save your markups.

Cedara I-Response E3

":‘:') Would yvou like to save current modified markups (iF any)?

oK I Cancel |

11. Click OK.

Using the Non-target Tool

This section describes how to use the Non-target tool. When you use the Non-
target tool, you are creating a focal point by drawing a non-measurable ellipse
around a lesion.

Note: When using the Non-target tool in conjunction with graphic layers, the NT
layer always remains active (see “To draw a non-target lesion using
the Non-target tool” on page 54).

Note: Non-target lesions appear in the Measurements Results Table; however,
their corresponding measurements columns are blank.

> To draw a non-target lesion using the Non-target tool

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Do one of the following:

= » In the Review Toolbar, click the non-target button.
* Right-click the viewport and select non-target from the popup menu.
.} Width,Lewvel

R .
Pixel Walue

Magnify Glass
RECIST
Crosshair

Mon Eargek

Disp. Area 3
Conkours 4
Delete Al

Auto Width/Lewel

‘Width/Level Presets
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Chapter 7: Using the Lesion Analysis Tools

3. Inthe first series, click and drag the mouse to draw an ellipse around the
lesion. When you release the mouse button, the application displays the
name of the NT layer (e.g., NT x, where x is the layer number).

TFE TRA  TITFE17

4. You may, for instance, want to delete and re-draw the Tumor 3 non-target
Add lesion: measurement. By default, the application increments the layer number of the
m next measurement drawn (e.g., Tumor 4). To avoid this and re-apply the
“Tumor 3” label, click Add Lesion in the Lesion group box and select the
appropriate number from the dropdown list.

5. Repeat Step 3 to draw additional non-target measurements on the second
series.

6. If desired, use the Active Layers dropdown list to draw non-target
measurements on different layers. When you draw a non-target measurement
on the first layer (e.g., NT 1), then draw another non-target measurement on a
second layer (e.g., NT 2), the non-target measurement on the first layer (e.g.,
NT 1) remains active. Measurements in both NT1 and NT2 layers appear
active in the viewport.

7. Click Save.
8. The application prompts you to save your markups.
Cedara I-Response

\‘_?/ wrould vou like to save current modified markups GF any)?

oK I Cancel |

55

e
i

CEDARAC
SOFTWARE



Cedara I-Response for NIH 1.1 User’s Guide

9. Click OK.

The example below displays an active non-target measurement on both NT and
CSF layers. The CSF layer is the active layer; however, the NT layer always
appears active. For details, see “Working with Graphic Layers” on page 35.

Inactive Layer NT Layer

(always active)

Active Layer

Navigating Measurements using the
Measurements Results Table

You can use the navigation feature on the Measurements Results Table to
navigate or “jump” to the associated measurement on the image.

> To navigate measurements

1. Load and display the patient series (see “Selecting and Loading Studies
for Review” on page 19).

2. Perform any of the procedures in “Measuring Lesions” on page 43 to
measure lesions and display the Measurements Results Table for
comparison.
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3. Inthe Measurements Results Table, click the required Volume, RECIST,
Crosshair or non-target row to jump to the associated target measurement on

the image.

Note:

Non-target lesions also appear in the Measurements Results Table;

however, their corresponding measurements columns are blank.

Exporting Measurements

After comparing volume, RECIST and crosshair measurements, you can export
the Measurements Results Table in .txt file format to a local data source.

Note:
be exported.

Non-target lesions that appear in the Measurements Results Table will not

> To export measurements

1. Load and display the patient series (see “Selecting and Loading Studies

for Review” on page 19).

2. Perform any of the procedures in “Measuring Lesions” on page 43 to
measure lesions and display the Measurements Results Table for

comparison.

3. Click Export.

4. The Export Measurements dialog box displays.

Specify the file name for the output txt file EHE
Save ir: Ixo Local Disk (C:) j L= & EB-

| BACKLIP FROM OLD DRIVE:
|5 cmsynergy
| "IData
| del
|_=)Documents and Settings
|2 drvrtmp

Desktop e
|-5) Inetpub

. \_=)Program Files
.7) Sample Images

My Docurnents | WINDOWS
or
-
4y Computer
.
7
Iy File: name: I j Save
Save as type: IText files [ twt] j Cancel |
7

5. Navigate to the appropriate local folder and type a file name.
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6. Select from the available file types, i.e., Text files (.txt) or CSV files (.csv).
7. Click Save.

8. The application saves the measurements from the Measurements Results
Table in the selected file format.
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Chapter 8: Using the Review Tools

This chapter describes how to use the standard image review tools. Depending on
the review tool you are using, you can access the tool:

» from the Review Toolbar (see “Using the Review Toolbar” on page 23);

» from the popup menu (see “Using the Popup Menu to Access Lesion
Analysis and Review Tools” on page 23); and

» from the MPR Properties group box (“Changing the MPR Properties” on
page 54).

Note: Throughout this document, we instruct you to select the appropriate
review tool from the Review Toolbar. If the tool is unavailable from the
Review Toolbar, we instruct you to use the popup menu.

Note: You can expand the Review Toolbar to access hidden review tools. To
expand the Review Toolbar, click the Toolbar Options button.

Correlating the 2D & MPR Viewing Protocols

The Correlation Point Tool is the default tool selected in the Main Review window.
By using this tool, you can triangulate all the MPR views to a single point that you
click. You can select a cross-correlation point on any of the MPR viewports, or on
the interactive volume viewport. The application automatically updates the cross-
reference lines found on all the MPR viewports to reference the selected point.

> To correlate the 2D & MPR viewing protocols

1. Inthe Review Toolbar, click the Correlate button.

2. Click a point on any of the viewports including the interactive volume viewport.

3. The application triangulates all the MPR views to the point that you have
clicked.
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Changing the MPR Properties

Using the tools in the MPR properties group box, you can define how images in
2D MPR Lesion view are displayed by adjusting the following properties:

» Slice Thickness — Increase/decrease the thickness of a slice.
» Mode — Project voxels into the rendered image.

* Interpolation — Resample the image using the available interpolation methods
to enhance quality:

Note: When you change the properties on images displayed in the 2D & MPR
viewing protocol, the application updates the images in all three
orthogonal planes.

—MPR properties
Slice Thickness

[10 i

Mode

I.-’-'werage j

Interpolabon

ILinear Cubic j

Reset |

Use the following procedures to change the slice thickness, mode and
interpolation properties.

> To change the slice thickness

1. Load and display the patient series (see “ Selecting and Loading Studies
for Review” on page 19.

2. Inthe Slice Thickness field, enter a value greater than one.

3. The application updates the images based on the selected thickness value.
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Chapter 8: Using the Review Tools

> To change the mode
1. Inthe Mode dropdown list, select one of the following properties:
e Average
» Maximum Intensity Projection

e Minimum Intensity Projection

Note: Updates to the mode are only visible when the thickness is greater than 1
pixel.

> To change the interpolation
1. Inthe Interpolation dropdown list, select one of the following properties:
» Nearest Neighbour — Nearest neighbour in X, Y and Z planes.
» Linear — Linear in X, Y and Z planes.
* Linear Cubic — Linear in X, Y planes, cubic in Z plane.
» Linear Nearest Neighbour — Nearest neighbour in X, Y planes, linear in Z
plane.
> To reset the properties
Feset 1. Inthe MPR Properties group box, click the Reset button.

2. The application resets the MPR properties to their default values.
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Changing the Position of the Cross-
Reference Lines

The cross-reference lines in each of the MPR viewports represent the image
displayed in each viewport. On color monitors, the lines are color-coded where
blue represents the left viewport, red represents the right viewport, and yellow
represents the middle viewport.

You can view any position in the series by changing the position of the cross-
reference lines. Since the change in view occurs in real time, it is referred to as
“melting through” the images.

> To melt through the images using the cross-reference lines

1. Click on any cross-reference line and drag it to the desired position.

Cross-reference
Line

Cross-reference
Line

2. The application updates the other viewports to reflect the new viewing plane.
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> To melt through the images using the mouse-wheel

Note: By default, you can rotate your mouse-wheel to melt through images.

1. Make an MPR viewport active.
2. Rotate the mouse-wheel:
« away from you to melt backward through the images; or

 toward you to melt forward through the images.

> To melt through the images using a three-button mouse

Note: By default, the three-button mouse is configured to scroll images when
you middle-click a viewport and move the mouse.

Eh » Middle-click an MPR viewport and with the mouse button pressed and:
! » drag the mouse pointer up to scroll backward through the images; or

» drag the mouse pointer down to scroll forward through the images.

Changing the Window Settings

The window settings (i.e., window width and window level) on digital images are
similar to the contrast and brightness, respectively, on your computer screen. The
window width can be wide (many grays, less contrast) or narrow (fewer grays,
more contrast). The window level can be high (dark) or low (bright).

Note: You cannot change the window settings for color images.

You can adjust the window settings using the mouse or using presets.

The windowing operation is sensitive to the speed at which you move the mouse.
If you move the mouse slowly, the window level changes will be relatively small. If
you move the mouse more quickly, the changes will be relatively larger. Also, the
changes will be relatively larger for higher resolution data.
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> To change the window settings
- 1. Inthe Review Toolbar, click the Window button.
2. The mouse pointer displays as shown here.
‘%D 3. Adjust the window width and/or level as follows:

 click and drag the mouse vertically over the selected image to adjust the
window level.

« click and drag the mouse horizontally over the image to adjust the window
width.

> To reset the window settings
1. Inthe Review Toolbar, click the Reset button.
=

2. The window width and/or level resets to their original values.

> To change the window settings preset

- 1. Inthe Review Toolbar, click the Window button and select Edit from the
menu.

2. Select the required window present from the Manage Width\Level Presets

dialog box.
|
Presz Mew to create a preset or select an existing prezet
to edit or delete,
Abd Soft Tissue MNew
Baone
Erain
Chest Ll
CTA :
Head
Lung
M arrow
b ediaztimumm
Soft Tizsue Delete |
Spine
Subdural
3. Click Close.
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> To change the window settings using the Auto Window/Level

tool
1. Inthe Review Toolbar, click the Window Preset tool.

2. Select Auto Window/Level from the menu.

Defining Window Presets

You should define window presets for all window settings that you intend to use
frequently. When you define a preset, it displays in the Window Presets list which
is arranged alphabetically.

Note: There is a different Window Presets list for each study modality, therefore
you must load a study of the appropriate modality before you can define
or edit presets for that modality.

The application automatically saves the window presets you define according to
your user name.

> To define a new window preset

- 1. Inthe Review Toolbar, click the Window button.

+

2. Use the mouse to adjust the window settings to the approximate values you
want to define.

3. Inthe Review Toolbar, click the Window button and select Edit from the
menu.

Manage Width'Level Presets #

Fress Mew to create a preset or zelect an esisting preset
to edit or delete.

Abd Soft Tissue New

Bone

Brain

Chest i |
CTa, Edit

Head

Lung

M arrow

Mediastimum

Saft Tissue Delste |
Spine

Subdural

Cloze

4. In the Manage Width\Level Presets dialog box, click New.
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5. Inthe New (Edit) Width\Level Preset dialog box, the application displays the
Width and Level values you applied in Step 2.

[HNew (Edit) Width'Level Pres oy ] 4

*#fidth

Lewvel |1 g0

Freset Mame:

Prezet 15

Save Cancel

6. If required, adjust the Width and Level values.
7. Type a name for the preset in the Preset Name field.

8. Click Save.

> To edit a window preset

1. Inthe Review Toolbar, click the Window Presets button and select Edit from
the menu.

2. Select the preset that you want to modify and click Edit.
3. Enter the required window width and level values.

4. Click Save.

> To delete a preset from the list

1. Inthe Review Toolbar, click the Window Presets button and select Edit from
the menu.

2. Click the preset in the list that you want to delete.

3. Click Delete.
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Zooming Images

You can zoom images and ROIs to examine them more closely.

> To zoom using the mouse

1.
2.
t
3.
4.

In the Review Toolbar, click the Zoom button. Alternatively, right-click the
active viewport and select Disp. Area, and Zoom from the popup menu.

The mouse pointer displays as shown here. The Zoom tool is active as long
as you have the mouse button pressed.

Click a point of interest on the image and drag the mouse vertically.

The application zooms to the point of interest.

> To zoom to an ROI

1.

Right-click the active viewport and select Disp. Area, and Zoom to ROI from
the popup menu.

The mouse pointer displays as shown here. The Zoom tool is active as long
as you have the mouse button pressed.

Click and drag the mouse to identify the region of interest filling the entire
viewport.

The application zooms to the region of interest

> To zoom to the cursor

1.

Right-click the active viewport and select Disp. Area, and Zoom to Cursor
from the popup menu.

The mouse pointer displays as shown here. The Zoom tool is active as long
as you have the mouse button pressed.

Click and drag the mouse to zoom the full image.
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Panning Images

You can pan or reposition the image within a viewport.

> To pan an image

1. Inthe Review Toolbar, click the Pan button._Alternatively, right-click the active
viewport and select Disp. Area, and Pan from the popup menu.

2. The mouse pointer displays as shown here.

3. Click and drag the image to change its position in the viewport.

Changing the Scope

The scope is the range of displayed images to which the application applies your
parameter changes (e.g., zooming, panning). You can choose one of three
settings:

» Active Image — The application applies the changes to current image only (i.e.,
the image in the highlighted viewport).

» Series — The application applies the changes to the active series.

« All Images W/L — The window/level changes are applied to all loaded images.

> To change the scope

1. Inthe Review Toolbar, click the Scope button and select the appropriate
scope setting from the menu (as described above).

All Trnages WL

2. The application changes the scope to the selected setting.

62

=
e —
i —T

——

CEDARA"®
SOFTWARE



Chapter 8: Using the Review Tools

Magnifying Images

A magnifier is provided so that you can magnify specific areas of interest on the

images. Only the images are magnified — overlay text, labels, etc., do not appear
in the magnified area.

> To magnify a selected area in an individual image

n 1. In the Review Toolbar, click the Magnify button.

2. Click the area that you wish to magnify. Drag the mouse to magnify another
area of interest.

Magnification Factor

Magnifier

3. The application displays the magnification factor at the top center of the
magnification area.

Note: You can increase the magnification factor up to 6x by clicking the right
mouse button while holding the left mouse button to after magnifying the
area of interest.
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Editing Measurements

This section describes how to edit (i.e., position, size) and delete lesion
measurements drawn on an image. To edit the lines, you must select the layer
that contains the lines you want to edit.

Editing Lesion, Crosshair and non-target
Measurements

Use the following procedures to edit measurements created using the Lesions,
Crosshair and Non-target tools.

> To resize a measurement
1. Click the measurement you want to resize.

2. The application displays grab handles at the end points of the selected
measurement.

3. Click a handle or end point and drag it to resize the measurement.

> To reposition a measurement
1. Click the measurement you want to reposition.

2. Drag it to the appropriate position.

> To delete a measurement

FE. 1. Right-click the measurement you want to delete.
!

2. Select Delete from the respective popup menu.

Delete

Delete Al Crosshairs
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> To delete all measurements
FH 1. Right-click the measurement you want to delete.
— 2. Select one of the following from the respective popup menus:
* Delete All Lesion — Only deletes lesion measurements.
» Delete All Crosshairs — Only deletes crosshair measurements.

» Delete All non-target Lesions — Only deletes non-target measurements.

Delete

65

e
i
[ —

—

CEDARA®
SOFTWARE



Cedara I-Response for NIH 1.1 User’s Guide

Editing Contour Measurements

Use the following procedures to edit measurements created using the Contours
tool.

> To hide a contour measurement

1. Right-click the contour you want to hide and select Hide Measurements from
) the popup menu.

p—

Hide Measurements
Edit: Contour Murmber
Delete Object

Inid Last Edit

2. The application hides the measurement.

> To show a contour measurement

1. If the contour’'s measurements are hidden, right-click the contour whose
measurements you want to show and click Show Measurements.

Show Measurements
Edit Contour Number
Delete Object
Inida Last Edit

> To edit the contour number

1. Right-click the contour whose number you want to edit and select Edit
) Contour Number from the popup menu.

p—

Show Measurements

Edit Contour Number
Delete Object
Inida Last Edit

2. Inthe Edit Contour Index dialog box, edit the contour number in the text box

provided.
Fleaze enter the new index of the selected contour.
[ =
Cancel | QK.
3. Click OK.
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> To delete a contour measurement

1. Right-click the contour you want to delete and select Delete Object from the
) popup menu.

p—

Show Measurements
Edit Contour Mumber

Delete Cbject

Unde Last Edit

2. The application deletes the measurement.

Querying the Density and Standard Uptake
Value (SUV)

In the 2D & Lesion MPR view, you can query the density and Standard Uptake
Value (SUV) of a specific point (pixel) on an image. The application can calculate
the following:

» Body weight SUV (SUVbw) measured in g/ml.

 Tissue density for CT measured in Hounsfield Units (HU).

WARNING: The accuracy of the SUV query is dependent on the
correctness of the values that you input as SUV related patient
information, as well as other factors such as the origin of the
data being queried. The SUV query output should be used only
as a guideline for trend analysis.

> To query the density/intensity of an image

1. In The Review Toolbar, click the Query Density/Standard Uptake Value button.
2. The mouse pointer displays as shown here.

3. Move the mouse pointer to a specific point of interest to display the pixel
value.

Note: If the image is missing SUV attributes, the SUV value is displayed as
“NA”.
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4. Move the mouse pointer to a specific point of interest.

Yalue:

Changing the Text Level

The text level is the level of information that the application displays in the image
viewports, sometimes called the overlay text or image text. You can choose one of
three levels.

None — Shows no information.
Basic — Shows only the basic text annotations.

Full — Displays the patient name, W/L settings, series ID, image ID and slice
location.
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> To change the text level

1. In The Review Toolbar, click the Select the text level button and select the
desired text level from the dropdown menu.

Changing the Color Palette

You can change the color scheme applied to images displayed in the Main Review
window. The application supports 8 color schemes.

None NucMed Reverse Reverse HotBlue  Thermal Hotlron  Rainbow
(standard)  Standard Hot Iron
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> To apply a color palette
1. Inthe Review Toolbar, click the Color Palette button.

2. Select the required color palette from the menu. For a description of the
available color palettes, see above

Haot Iron

Thermal
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